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1. Solving a Vision Problem

A typical vision-based application follows these steps:

1. Acquire images

External images must be stored in a host PC memory buffer with a known address. They must
be linked to the Open eVision image object with parameters containing the address and pitch
(32 bytes default) of the buffer, and the width and height of the image.
For details see Image Construction and Memory Allocation.

● To optimize resolution and repeatability, the area of interest should occupy most of the field
of view, and the targeted inspection equipment should be simulated as accurately as
possible, with realistic lighting.

● You should create two series of images:
□ Objects without defects (accepted by the inspection process) in all situations (such as

unstable lighting conditions and movement freedom).
□ Objects with unacceptable defects (to be rejected by the inspection process).

Use Open eVision Libraries to process the images:

2. Pre-process images

● Reduce defects or enhance properties (such as contrast between the object of interest and
background).

3. Locate objects of interest

● Locate the area of interest using techniques such as segmentation, edge detection or pattern
matching.
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4. Analyze your findings

● Use a measurement tool:
□ EasyObject measures unknown shapes.
□ EasyGauge returns accurate measurements of known objects.
□ EasyImage provides statistical parameters.

● Measurements are performed locally so quantify the shape of objects geometrically, defects
can be related to abnormal gray-level values.

5. Optimize your application

● Your solution must reliably separate good images from bad images by comparing ROI
features to assess quality, detect defects, and recognize and sort objects.

● If it can't, repeat steps 2 and 3 to improve your set of features.

Develop thread safe applications

● Open eVision supports simultaneous execution by multiple (unlimited) threads on the same
CPU, but data can only be accessed by one thread at a time
So independent tasks can execute simultaneously in your application, but each bit of shared
data must be controlled by a separate task.

● Follow the rules about thread-safe classes listed in Multicore Processing to avoid data
corruption, crashes and misbehaving programs.

Report errors

● When an Open eVision function fails, an exception is thrown which contains an error code
and a description. To catch a potential exception, the function call is included in a try-catch
block.

Measure execution times

● Timing a particular piece of code is achieved simply with start and stop operations:
□ Start timing: Easy::.StartTiming
□ Stop timing: Easy::.StopTiming
□ Clock resolution: Easy::.TrueTimingResolution

Help is available

● Open eVision Studio
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□ Speeds up and automates the creation of a solution. You can test the functions to find
appropriate parameter values, and generate code of your operations to copy and paste
into prototype applications.

● Open eVision examples:

Euresys download area contains:
□ sample projects: how to use Open eVision libraries with a particular IDE.
□ sample application programs: how to combine Open eVision functions and libraries in a

variety of combinations and applications.
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2. Discovering Open eVision Libraries

Open eVision is a set of powerful image processing tools developed for computer vision
applications. They cover most state-of-the-art techniques in digital image processing, from
classical algorithms to advanced solutions ready-made for specific tasks.

Many of the available tools are designed to be self-consistent and easy to use. Nevertheless, for
more advanced uses, you should find everything you need to build you own workflow by
combining the numerous building blocks provided.

Open eVision is made of a set of C++ and .NET classes ready for integration in your application.
The tools are in no way a closed solution and do require to be integrated in your own
application, leaving you all the freedom to deal with all other aspects of the automation not
related to image processing.

□ Basic Types and Operations contains the definition of fundamental objects, types, classes
and functions used in all Open eVision components.

General Purpose Libraries

□ EasyImage offers gray-level image processing functions that improve image quality and
contrast between background and objects of interest as well as linear and non-linear
filtering and geometric transformations. It also offers tools for quantifying image focus,
sliding window statistics and histogram analysis.

□ EasyColor contains color image processing functions that efficiently convert images
between several color systems.

Matching and Measurement Tools

□ EasyObject obtains information about distinct objects (blob analysis), identifies them
using connected component labeling, then sorts and selects them according to their
geometric features. EasyObject 2 contains advanced blob detection and analysis tools.

□ EasyGauge assesses dimensions of objects to sub-pixel precision, detects edges, locates
points and fits geometric models. If the field of view is calibrated, it also measures in
physical units (mm, inch...) instead of pixels.

□ EasyFind locates patterns in an image based on a geometrical model from a reference
pattern or template. Compared to EasyMatch, it is computationally fast, robust against
noise, occlusion, blurring and illumination variations.

□ EasyMatch locates patterns in an image based on a pixel-by-pixel comparison with a
reference pattern or template. It can be used for image registration or component
placement inspection.

□ EChecker2 creates a golden template and inspects images.

Text and Code Reading Tools

□ EasyBarCode reads bar codes.
□ EasyMatrixCode and EasyMatrixCode2 read data matrix codes.
□ EasyQRCode detects and decodes QR codes.
□ EasyOCR performs optical character recognition. You can use it for reading serial

numbers or printed labels.
□ EasyOCR2 offers advanced and improved optical character recognition functions.
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Deep Learning Inspection Tools

□ Deep Learning Tools inspects images with deep learning technology.
□ EasyClassify classifies images.
□ EasySegment, supervised or unsupervised, detects and segments images.

3D Processing Tools

□ Easy3D offers a set of tools for solving computer vision problems using 3D acquisition
and processing.

□ Easy3DLaserLine retrieves, extracts and calibrates the laser line in images.
□ Easy3DObject extracts 3D objects in images.
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3. Dealing with Pixel Containers and
Files

3.1. Pixel Container Definition

Images

Open eVision image objects contain image data that represents rectangular images.

Each image object has a data buffer, accessible via a pointer, where pixel values are stored
contiguously, row by row.

Image main parameters

An Open eVision image object has a rectangular array of pixels characterized by EBaseROI
parameters .

l Width is the number of columns (pixels) per row of the image.
l Height is the number of rows of the image. (Maximum width / height is 32,767 (215-1) in

Open eVision 32-bit, and 2,147,483,647 (231-1) in Open eVision 64-bit.)
l Size is the width and height.

The Plane parameter contains the number of color components. Gray-level images = 1. Color
images = 3.

Classes

Image and ROI classes derive from abstract class EBaseROI and inherit all its properties.
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Depth maps

A depth map is a way to represent a 3D object using a 2D grayscale image where each pixel in
the image represents a 3D point.

The pixel coordinates are the representation of the X and Y coordinates of the point while the
grayscale value of the pixel is a representation of the Z coordinate of the point.

Point clouds

A point cloud (https://en.wikipedia.org/wiki/Point_cloud) is an unstructured set of 3D points
representing discrete positions on the surface of an object.

Open eVision Getting Started PART I Open eVision Basics
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3D point clouds are produced by various 3D scanning techniques, such as Laser Triangulation,
Time of Flight or Structured Lighting.

3.2. Pixel Container Types

Reference

Images

Several image types are supported according to their pixel types: black and white, gray levels,
color, etc.

Easy.GetBestMatchingImageType returns the best matching image type for a given file on disk.

BW1 1-bit black and white images (8 pixels
are stored in 1 byte) EImageBW1

BW8 8-bit grayscale images (each pixel is
stored in 1 byte) EImageBW8

BW16 16-bit grayscale images (each pixel is
stored in 2 bytes) EImageBW16

BW32 32-bit grayscale images (each pixel is
stored in 4 bytes) EImageBW32

C15

15-bit color images (each pixel is
stored in 2 bytes).
Compatible with Microsoft® Windows
RGB15 color images and MultiCam
RGB15 format.

EImageC15
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C16

16-bit color images (each pixel is
stored in 2 bytes).
Compatible with Microsoft® Windows
RGB16 color images and MultiCam
RGB16 format.

EImageC16

C24

C24 images store 24-bit color images
(each pixel is stored in 3 bytes).
Compatible with Microsoft® Windows
RGB24 color images and MultiCam
RGB24 format.

EImageC24

C24A

C24A images store 32-bit color images
(each pixel is stored in 4 bytes).
Compatible with Microsoft® Windows
RGB32 color images and MultiCam
RGB32 format.

EImageC24A

Depth Maps

8 and 16-bit depth map values are stored in buffers compatible with the 2D Open eVision
images.

EDepth8 8-bit depth map (each pixel is stored in
1 byte as an integer) EDepthMap8

EDepth16 16-bit depth map (each pixel is stored
in 2 bytes as a fixed point) EDepthMap16

EDepth32f 32-bit depth map (each pixel is stored
in 4 bytes as a float) EDepthMap32f

Point Clouds

Point Cloud Set of points coordinates (stored as
float) EPointCloud

3.3. Supported Image File Types

Reference

Type Description

BMP Uncompressed image data format (Windows Bitmap Format)

JPEG Lossy data compression standard issued by the Joint Photographic Expert
Group registered as ISO/IEC 10918-1. Compression irretrievably loses quality.

JFIF JPEG File Interchange Format

JPEG-2000
Data compression standard issued by the Joint Photographic Expert Group
registered as ISO/IEC 15444-1 and ISO/IEC 15444-2. Open eVision supports
only lossy compression format, file format and code stream variants.
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Type Description

- code stream describes the image samples.
- file format includes meta-information such as image resolution and color
space.

PNG Lossless data compression method (Portable Network Graphics).

Serialized Euresys proprietary image file format obtained from the serialization of Open
eVision image objects.

TIFF

Tag Image File Format is currently controlled by Adobe Systems and uses the
LibTIFF third-party library to process images written for 5.0 or 6.0 TIFF
specification.
File save operations are lossless and use CCITT 1D compression for 1-bit
binary pixel types and LZW compression for all others.
File load operations support all TIFF variants listed in the LibTIFF
specification.

3.4. Pixel and File Types Compatibility

Depth map to image conversion

For 8- and 16-bit depth maps, the AsImage() method returns a compatible image object
(respectively EImageBW8 and EImageBW16) that can be used with Open eVision’s 2D processing
features.

Pixel and file types compatibility

Pixel access

The recommended method to access pixels is to use SetImagePtr and GetImagePtr to embed the
image buffer access in your own code. See also Image Construction and Memory Allocation and
Retrieving Pixel Values.

Use of the following methods should be limited because of the overhead incurred by each
function call:

Direct access

EROIBW8::.GetPixel and SetPixel methods are implemented in all images and ROI classes to read
and write a pixel value at given coordinates. To scan all pixels of an image, you could run a
double loop on the X and Y coordinates and use GetPixel or SetPixel each iteration, but this is not
recommended.
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TIP
For performance reasons, these accessors should not be used when a
significant number of pixels needs to be processed. When that is the case,
retrieving the internal buffer pointer using GetBufferPtr() and iterating on the
pointer is recommended.

Quick Access to BW8 Pixels

In BW8 images, a call to EBW8PixelAccessor::.GetPixel or SetPixel will be faster than a direct
EROIBW8::.GetPixel or SetPixel.

Supported structures

l EBW1, EBW8, EBW32
l EC15 (*), EC16 (*), EC24 (*)
l EC24A
l EDepth8, EDepth16, EDepth32f,

(*) These formats support RGB15 (5-5-5 bit packing), RGB16 (5-6-5 bit packing) and RGB32 (RGB
+ alpha channel) but they must be converted to/from EC24 using EasyImage::.Convert before any
processing.

NOTE
Transition with versions prior to eVision 6.5 should be seamless: image pixel
types were defined using typedef of integral types, pixel values were treated
as unsigned numbers and implicit conversion to/from previous types is
provided.

Pixel and File Type compatibility during Load or Save operations

Type BMP JPEG JPEG2000 PNG TIFF Serialized

BW1 Ok N/A N/A Ok Ok Ok

BW8 Ok Ok Ok Ok Ok Ok

BW16 N/A N/A Ok Ok Ok
(***) Ok

BW32 N/A N/A N/A N/A Ok
(***) Ok

C15 Ok Ok (**) Ok (**) Ok (**) Ok (**) Ok

C16 Ok Ok (**) Ok (**) Ok (**) Ok (**) Ok

C24 Ok Ok Ok Ok Ok (**) Ok

C24A Ok N/A N/A Ok N/A Ok

Depth8 Ok Ok Ok Ok Ok Ok
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Type BMP JPEG JPEG2000 PNG TIFF Serialized

Depth16 N/A N/A Ok Ok Ok
(***) Ok

Depth32f N/A N/A N/A N/A N/A Ok

N/A: Not supported. An exception occurs if you use the combination.

Ok: Image integrity is preserved with no data loss (apart from JPEG and JPEG2000, lossy
compression).

(**) C15 and C16 formats are automatically converted into C24 during the save operation.

(***) BW16 and BW32 are not supported by Baseline TIFF readers.

3.5. Color Types

EISH: Intensity, Saturation, Hue color system.

ELAB: CIE Lightness, a*, b* color system.

ELCH: Lightness, Chroma, Hue color system.

ELSH: Lightness, Saturation, Hue color system.

ELUV: CIE Lightness, u*, v* color system.

ERGB: NTSC/PAL/SMPTE Red, Green, Blue color system.

EVSH: Value, Saturation, Hue color system.

EXYZ: CIE XYZ color system.

EYIQ: CCIR Luma, Inphase, Quadrature color system.

EYSH: CCIR Luma, Saturation, Hue color system.

EYUV: CCIR Luma, U Chroma, V Chroma color system.
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1. Selecting your Programming
Language

When you start Open eVision Studio for the first time, the following welcome screen is
displayed:

1. Select your programming language.

TIP
Your selection is saved and your programming language will be
automatically selected next time you start Open eVision Studio.

NOTE
When you change your programming language, any script present in the
scripting window is automatically deleted and the window content is reset.

2. Click on one of the Load buttons to already load one or several images for later processing.

3. Check the Do not show at startup box to hide this welcome screen next time you start Open
eVision Studio.

TIP
To access this welcome screen at any time, and change this setting, go to
the Help > Welcome Screen menu.

Open eVision Getting Started PART II Open eVision Studio for
Library Evaluation
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2. Navigating the Interface

Open eVision Studio graphical user interface (GUI) is organized as follows:

1. The main menu bar gives you access to the functions and tools of all libraries.

TIP
Open eVision Studio does not require any license and allows you to test all
libraries. Of course, if you copy code from Open eVision Studio in your own
application but you do not have the required license, you will receive a
"missing license" error at run-time.

2. The main toolbar gives you quick access to main Open eVision objects such as images,
shapes, gauges, bar codes, matrix codes...

3. The script window displays the code, in the programming language you selected,
corresponding to the actions you perform in Open eVision Studio. You can save or copy this
code in your own application at any time.

4. The image windows display the open images that you can process using the libraries and
tools.

5. The tool windows enable you to easily configure all the available tools. The corresponding
settings are automatically added in the script window for easy reuse.

TIP
Most tool windows are floating and you can easily move them outside the
Open eVision Studio main window to make better use of your screen size.

Open eVision Getting Started PART II Open eVision Studio for
Library Evaluation
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6. The execution time bar displays the precise time taken for the execution of the selected
functions (measured in milliseconds or microseconds) on your computer. This accurate
measurement helps you to evaluate the performance of your application.

7. The color toolbar displays current information such as the X and Y coordinates of the cursor
on an image and the corresponding pixel value.

8. The status bar displays general information about the application such as the active image
file path...

Open eVision Getting Started PART II Open eVision Studio for
Library Evaluation
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3. Running Tools on Images

3.1. Step 1: Selecting a Tool

When you use Open eVision Studio, the first step is to select the library and the tool you want to
use on your image.

To do so:

1. In the main menu bar, click on the library you want to use.

2. Click on the tool you want to use.

TIP
All libraries (except EasyImage, EasyColor and EasyGauge) expose only one
tool named New Xxx Tool. Some of these libraries also expose additional
functions.

3. In the dialog box, enter a Variable name for the variable that is automatically created and
that will contain the result of the processing.

Example of variable creation dialog box for EasyQRCode

4. Click OK.

The selected tool dialog box opens.

Open eVision Getting Started PART II Open eVision Studio for
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Example of variable creation dialog box for EasyQRCode

The next step is "Step 2: Opening an Image" on page 22.

3.2. Step 2: Opening an Image

Once you have selected your library and your tool, you need to open an image to apply this
tool.

In the Source Image area of the selected tool dialog box:

1. Open an image:

□ Click on the Open an Image button and select one or several (using SHIFT and CTRL)
images on your computer.

□ Or select one of the images (or one of the ROIs, if any) already open in the drop-down list.

NOTE
You can select only images with an appropriate file format (JPG, PNG, TIFF
or BMP) and in 8- and/or 24-bit depending on the library.

2. If you selected several images, activate one with the  Load Previous or  Load Next
buttons.

Open eVision Getting Started PART II Open eVision Studio for
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The tool is automatically applied on any loaded image and, at this stage, the result is displayed
based on the tool default settings.

The next step is "Step 3: Managing ROIs" on page 23.

3.3. Step 3: Managing ROIs

In some cases, most often to decrease the processing time or to single-out the object you want
to read, you do not want to process the whole image but only one or several well defined
rectangular parts of this image, or ROIs (Regions Of Interest).

TIP
In Open eVision, ROIs are attached to an image and exist only as long as the
parent image is available.

Creating a ROI

1. Open the image:
□ If the image is already open, activate the corresponding image window.
□ If the image is not open yet, go to the main menu: Image > Open... to open one.

2. To create an ROI, go to the main menu: Image > ROI Management....

The ROI Management window is displayed as illustrated below.

3. Select the image in the tree.

4. Click on the New button.

5. In the dialog box, enter a Variable name for the new ROI.

The ROI is represented as a color rectangle on your image as illustrated below.

Open eVision Getting Started PART II Open eVision Studio for
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6. Drag the ROI corner and side handles to move it to the required position.

7. Click on the Close button to close the ROI Management window .

The next step is "Step 4: Configuring the Tool" on page 25.

Managing ROIs

You can add, change and remove ROIs.

TIP
An image can have several ROIs. Each ROI can be attached directly to the
image (meaning that its position is relative to the image) or to another ROI
(meaning that its position is relative to this 'parent' ROI).

1. To manage ROIs, go to the main menu: Image > ROI Management....

The ROI Management window is displayed with the ROI relation tree as illustrated below.

If the Draw Rois box is checked, all ROIs are displayed on the image with a different color.

Open eVision Getting Started PART II Open eVision Studio for
Library Evaluation



25

2. Select an ROI in the ROI relation tree.

3. Drag the ROI corner and side handles to change the position and size of the selected ROI (as
well as the position of all ROIs attached to it if any).

4. Click on the New button to add a new ROI attached to the selected ROI.

TIP
Select the image at the top of the ROI relation tree to attach the ROI directly
to the image.

5. Click on the Remove button to delete the selected ROI (and all ROIs attached to it if any).

6. Click on the Close button to close the ROI Management window.

3.4. Step 4: Configuring the Tool

Once your image, including its ROIs if you created some, is ready, you need to configure your
tool.

In the tool window:

1. Open the various tabs.

TIP
When you create a new tool, all parameters are set with their default value.

Open eVision Getting Started PART II Open eVision Studio for
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Example of the parameter tab of an EasyQRCode tool

2. In each tab, set the value of the parameters as desired.

Please refer to the "Functional Guide" and to the "Reference Manual" for detailed information
about the parameters, their function and their default value.

For specific actions such as learning or using gauges, please refer to the "Functional Guide".

3. Run the tool and analyze the results as described in the next step "Step 5: Running the Tool
and Checking Execution Time" on page 26.

3.5. Step 5: Running the Tool and Checking
Execution Time

Once your tool parameters are set, run your tool and, if desired, check the execution time on
your computer.

In the tool window:

1. Click on the Read, Detect, Results or Execute button (depending on the library function), to
run the tool on the selected image.

2. Check the results on the image and in the Results field or area as illustrated below.

Open eVision Getting Started PART II Open eVision Studio for
Library Evaluation
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Example of results after reading a QRCode

3. If you do not have the expected results:
□ Try to change your parameters (start with default values then change one parameter at a

time).
□ If your image is not good enough, try to enhance it as described in .

4. Check the execution time in the execution time bar at the bottom left of the main Open
eVision Studio window.

The execution time

TIP
The execution time is the actual time that the processing took as measured
on your computer. It depends your computer processor, memory, operating
system... and, of course, on the processor load at the time of execution. Thus
this execution time slightly varies from execution to execution.

5. To get a more representative execution time, click on the Read, Detect, Results or Execute
button several times and calculate the mean execution time.

6. If your application requires that you reduce the execution time, try:
□ To change the tool parameters,
□ To add one or several ROIs on your image,
□ To enhance your image.

The next step is "Step 6: Using the Generated Code" on page 28.

Open eVision Getting Started PART II Open eVision Studio for
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3.6. Step 6: Using the Generated Code

By default, Open eVision Studio translates all the operations you perform in the interface into
code in the language you selected as illustrated below.

Once your tool results suit you, you can save or copy this generated code to use it in your own
application.

Copy and paste the code in your application

In the script window:

1. Select the code section you want to copy.

2. Right click on this code and click Copy in the menu.

3. Go to your development environment tool and paste the code in place.

Save the code

1. Go to the Script menu.

2. Click on Save Script As....

3. Enter a file name and path to save the code as a text file.

Manage the generated code

In the Script menu, you can:
□ Select the programming language (please note that if you change the language, the script

window content is automatically deleted).
□ Activate or deactivate the Script Code Generation. Deactivate this option if you want to

perform some operations without saving them as code.
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4. Pre-Processing and Saving Images

When should you pre-process your images?

Of course, the best situation is to set up your image acquisition system to have good and easy
to process images so the Open eVision tools run smoothly and efficiently.

If this is not possible or easy to achieve, you can pre-process your images or your ROIs to
enhance and prepare them for the Open eVision tool you want to run.

Using the various available functions, you can adjust the gain and offset of your image, apply a
convolution, threshold, scale, rotate and white balance your image, enhance contours... using
EasyImage and EasyColor functions.

Pre-processing images

The difference between pre-processing an image and running tools is that the pre-processing
generates a new image while the tools mainly extract and retrieve information from the image
without changing it.

To pre-process an image or an ROI:

1. In the main menu bar, click on the library you want to use (EasyImage or EasyColor).

2. Click on the function you want to use.

Most function dialog boxes are similar to the one illustrated below with 2 image selection areas
and a parameter setting area.

Example of a pre-processing dialog box (Threshold with EasyImage)

3. If there are multiple versions for your selected function, open the corresponding tab.

4. In the Source Image area, open the source image (as described in "Step 2: Opening an
Image" on page 22).

5. In the Destination Image area, open or create a new destination image.

6. Set your parameters.

7. Click on the Execute button.

The pre-processed image is available in the destination image as illustrated below.
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Source and destinations images (Threshold with EasyImage)

8. If you want to use the destination image outside of Open eVision Studio, save it as described
below.

Saving an image

1. Click on the image you want to save to makes its window active.

2. To open the save menu either:
□ Right-click in the image
□ Or open the main menu > Image

3. Click on Save as....

4. Select the file format (JPEG, JPEG2000, PNG, TIFF or Bitmap).

5. Enter a name and select a path.

6. Click on the Save button.
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1. Start the Application and Open a
Project

1. Launch Easy3D Studio.

The following screen is displayed:

2. Select your stream in the list of the available streams displayed in the Select Stream area.

3. Open your project (.json file):
□ Click on Create Project to create a new project.
□ Click on Load Project to open an existing project.

Open eVision Getting Started PART III Easy 3D Studio for 3D
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The main screen is displayed as illustrated:
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2. Configure the Acquisition ROI

1. Open the Profile tab.

2. Click on the  run button to start free-running acquisition.
3. Place your caliber or your object under the laser line.

TIP
To optimize the computation time, make sure the laser line illuminates the
lowest as well as the highest areas of the object.
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4. In the Profile window, move and resize the ROI (the green rectangle) to fit and enclose the
laser line image.

TIP
With a smaller the ROI, the extraction computation is faster and the
resolution is better.

5. In the parameter list, select the ExtractionMethod to use to compute the laser line extraction.

TIP
Do not use MaxDetection_8 if your ROI height is larger than 256 as this would
introduce a saturation effect in the extraction result.

6. Once the setup is complete, click on the  pause button to stop the acquisition.

Open eVision Getting Started PART III Easy 3D Studio for 3D
Evaluation



36

3. Calibrate the Setup

1. Open the DepthMap tab.

2. Place your caliber on your system.

3. Click on the  run button to start an acquisition.
4. Move the caliber under the camera and wait for the image acquisition to complete.

5. Once the acquisition is displayed, click on the  pause button to stop the acquisition.
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6. Open the PointCloud tab.

7. Use the mouse on the image to freely move it around in 3D.
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8. In the parameter list:
□ Set CalibrationMethod to ObjectBasedMethod.
□ Select the Objecttype corresponding to your caliber.

9. Click on the Calibrate button.

After some processing, the calibrated image point cloud is displayed.

Open eVision Getting Started PART III Easy 3D Studio for 3D
Evaluation



39

4. Acquire a Depth Map

1. Open the DepthMap tab.

2. Place your object on your system.

3. Click on the  run button to start an acquisition.
4. Move the object under the camera and wait for the image acquisition to complete.

5. Once the acquisition is displayed, click on the  pause button to stop the acquisition.
The "raw" image of your object is displayed.
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6. Open the PointCloud tab.

The calibration correction is applied to the image before display.

7. Use the mouse on the image to freely move it around in 3D.
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8. Open the ZMap tab.

The corresponding ZMap is generated and displayed.

9. Configure the ZMap view:
□ Select the projection axis of the image: set the ReferencePlaneMode as X, Y or Z-plane.
□ Along the selected axis, set the offset of the displayed image.

10.Click on the Compute button to apply your changes and display the new image.
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5. Export a ZMap

1. Open the File menu.

2. Click on Export ZMap.

3. Select the type of file you want to create:
□ PNG
□ TIFF
□ BMP (Bitmap)

4. Enter the file name.

5. Click on the Save button.

You can also save a profile, a depth map or a point cloud the same way.

The available file formats are:
□ Profile: PNG, TIFF, Bitmap
□ Depth map: PNG, TIFF, Bitmap
□ Point cloud: PCD
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6. Add or Remove Parameters

The parameters listed in the different tabs are the basic software parameters that you need to
control and adjust to use Easy3D Studio.

In the Profile and in the DepthMap tabs, you can add some hardware parameters (related to the
frame grabber or to the camera) that you want to quickly and easily display or control:

1. Open the GenICam menu.

2. Click on GenICam.

The GenICam window opens as illustrated.

3. To show or hide a parameter, click on the 'eye' icon:
□ Left : the parameter is hidden in the Profile tab.
□ Right : the parameter is hidden in the DepthMap tab.
□ Left : the parameter is displayed in the Profile tab.
□ Right : the parameter is displayed in the Profile tab.

TIP
The changes are automatically and immediately applied in the Easy3D
Studio main window.

4. Close the GenICam window .

5. To save your changes, open the File menu and click Save Project.
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1. What is the Neo Licensing System?

What is the Neo Licensing System?

● Neo is the name of the new licensing system of Euresys. It will progressively protect the
software products from Euresys.

● The Neo Licensing System is used for Open eVision, where it is supported in addition to the
already existing licensing systems. In the future, il will also protect some features in the
eGrabber software tool and other products.

Why the Neo Licensing System?

● The Neo Licensing System brings reliable, up-to-date IP protection to Euresys products as
well as more flexibility for the users.

● In the future, it will also enable useful licensing options such as network licenses
compatibility.

How does the Neo Licensing System work?

To use a product protected by the Neo Licensing System:

1. Buy the corresponding license from Euresys or one of its distributors.

2. You receive a Ticket ID corresponding to that license.
□ This Ticket ID is used to get the license.
□ This Ticket ID is necessary to communicate with your seller in case of an issue.
□ So, keep it safe and archived for any future use.

3. Use the Ticket ID to activate the license on your computer.

You can activate your license either directly on the computer, as a software license, or on a
Neo USB Dongle, that you can buy from Euresys.
□ Until you decide on which container (computer or dongle) you want to put your license,

this license is not linked to anything.

TIP
You can activate a Neo License directly on a computer. Nevertheless, we
recommended to use a Neo USB Dongle to have a more secure and an easily
portable license storage solution.

4. Use your Euresys product.

The Neo License Manager tool

● A new license management tool, the Neo License Manager, is available to activate, check and
debug problems that might arise with Neo Licenses.

It comes in 2 versions:
□ As an application with a user interface, complete and easy-to-use.
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□ As a command-line utility to automate your processes such as the product installations.
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2. Selecting the Licensing Model

Starting with Open eVision 2.13, you can select the Open eVision licensing model(s) that you use
with your application.

TIP
This avoids the delays that are sometimes added by the initialization of
licensing models you do not use.

The SelectLicensingModel function

● To select the licensing models to enable with Open eVision, call the following function:
Preconfiguration::SelectLicensingModels(ELicensingModel model)

● Always call it before any other Open eVision function as calling it after the first call to Open
eVision has no effect.

● The SelectLicensingModels function takes a single argument:
□ The licensing models to enable, as described by the ELicensingModel enumeration.

The ELicensingModel enumeration

● The ELicensingModel enumeration contains the different licensing models you can enable
within Open eVision:
□ Neo: the new licensing model introduced with Open eVision 2.13.
□ LegacyDongle: the licensing model associated to the dongles used before 2.13.
□ LegacySoftware: the licensing model associated to the software-based licenses used before

2.13
□ Legacy: this licensing model mirrors the licensing as it operated in Open eVision before 2.13

(LegacyDongle + LegacySoftware).
□ All (default): this licensing model enables all the others (Neo + LegacyDongle +

LegacySoftware).

● To use another combination of licensing models, use the |(OR) operator as follows:
Preconfiguration::SelectLicensingModels(ELicensingModel_LegacyDongle | ELicensingModel_Neo)
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3. Using the User Interface

The Neo License Manager user interface

The Neo License Manager is organized in 5 zones:

1. A list of the license containers and the licenses they contain.

2. The interface language configuration.

3. The online Neo License activation.

4. The offline Neo License activation.

5. The troubleshooting.

Activate an online license

1. Click on the Activate a license button to open the License activation dialog.

2. Enter the required information:
□ The container on which you want to activate the license.
□ The Ticket ID (5 groups of 5 alphanumeric characters separated by a dash).
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If there is no software license container yet, the dialog proposes you to create a new one.

System reinstallation

If you have to reinstall the system and lost your licenses:

1. Activate the license with the old Ticket ID to try to recover all the licenses associated to the
container where you first activated this Ticket ID.

This only works if:
□ It is done in a new, empty container.
□ The system is recognizable (the hardware is more or less the same).

2. If this does not work or if you lost your licenses and the system has changed significantly (for
instance after the failure and replacement of a hardware component), you need to request a
reactivation:
□ Contact the support to obtain a reactivation authorization for the corresponding Ticket ID.
□ Once the reactivation is authorized, perform the license activation procedure as usual.
□ The Neo License Manager asks for the confirmation of the reactivation.

NOTE
The reactivation disables the previous activation on the other system.
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Activate an offline license

The offline license activation allows you to activate licenses on a machine A that is not
connected to the Internet through a machine B that is connected to the Internet.

The offline license activation is a 3 steps procedure:

1. On machine A:

a. Click on the Get fingerprint file button to open the Get a fingerprint file dialog.

b. Enter the required information:
□ The license container on which you want to activate the license.
□ The path to save the fingerprint file.

2. On machine B:

a. Click on the Online request of license file for offline activation button to request
the corresponding license file.

b. Enter the required information:
□ The Fingerprint file from machine A.
□ The License file output path to save the license file.
□ The Ticket ID (5 groups of 5 alphanumeric characters separated by a dash) for the license.

3. On machine A:

a. Click on the Apply license file button.

b. Select the license file generated in step 2.
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Preparing a dongle to use the OEM key functionality

● You can use the Neo USB Dongles with the OEM Key functionality provided by Easy::SetOEMKey
and Easy::CheckOEMKey.

● When a preparation is required, a warning text appears in the list of the dongle licenses.

● Click on that text and follow the instructions.
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Troubleshooting

1. Click on the Emergency activation and report button to open the Troubleshooting dialog.

2. Click on the Apply emergency license button to temporarily activate licenses:
□ These licenses activate all Euresys products.
□ They are valid for 8 days.
□ You can repeat this a maximum of 3 times.
□ For security reasons, you cannot activate emergency licenses on virtual machines.

3. Click on the Save report to file button to generate a licensing system report and save it to
a file.
□ The support team may require this report when you have a licensing issue.
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4. Using the Online Command Line

● When you order a Neo License, Euresys sends you a Ticket ID required to activate the license
on your system.
□ A Ticket ID is made of 5 groups of 5 alphanumeric characters separated by a dash.

For example: TT5YY-HYAGN-Q2PBU-U7K7J-DKJJQ
□ You can activate your license either directly on the computer, as a software license, or on

a Neo USB Dongle, that you can buy from Euresys.

● In the case of the software container, the license is strongly linked to a single computer
system, while with a dongle you can move it easily from computer to computer.

Select a container

1. To select a license container, use the ListContainers command of the Neo License Manager.

All the containers compatible with Euresys licenses are listed:

> NeoLicenseManagerCL.exe ListContainers
Container list:

130-3613949292 (software)
□ A software container appears in the list with a serial number starting with 130-.
□ A dongle appears in the list with a serial number starting with 3-. This serial number is

also written on the dongle itself.

2. To create a software container, use the CreateSoftwareContainer command of the Neo License
Manager.

> NeoLicenseManagerCL.exe CreateSoftwareContainer
Software container 130-3245488904 has been created.

If you already have a software container on your system:
□ We highly recommended you to use that one.
□ Create a new software container only if the old one is broken for any reason. The old

license container unavailable for activation purposes.

3. Copy the serial number of the container you want to use for the next step.

Activate the license

1. To activate the license, use the ActivateLicense command of the Neo License Manager with the
serial number of the container.

> NeoLicenseManagerCL.exe Activate -t TT5YY-HYAGN-Q2PBU-U7K7J-DKJJQ -sn 130-3245488904
Activation of ticket TT5YY-HYAGN-Q2PBU-U7K7J-DKJJQ has been done succesfully.

The command associates the Ticket ID to the container and activates the license.
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Check the Neo License presence

1. To check the presence of the license, use the ListLicenses command of the Neo License
Manager.

The new license appears under the serial number of the license container.

> NeoLicenseManagerCL.exe ListLicenses
Licenses on container 130-3613949292 (software):

Open eVision EasyOCR

Activating the OEM key feature

By default, the dongles come with the OEM key feature activated. Nevertheless, older dongles
may have to be activated.

● To check if this feature is activated use the CheckOEMKeyReadiness command:

> NeoLicenseManagerCL.exe CheckOEMKeyReadiness –sn 3-3613949292

● If the feature is not activated on the dongle, use the PrepareForOEMKey command to activate it:

> NeoLicenseManagerCL.exe PrepareForOEMKey –sn 3-3613949292

Forcing more than one copy of the same license

● By default, the license manager protects you against multiple activations of the same license
in a container, refusing the subsequent activations:

● If you want to bypass that protection, use the –force flag:

> NeoLicenseManagerCL.exe Activate –force -t TT5YY-HYAGN-Q2PBU-U7K7J-DKJJQ -sn 130-3245488904

Troubleshooting

Command line help

● To get help about the syntax and the usage of the command line, use the Help command:

> NeoLicenseManagerCL.exe Help
Here are the available commands and their arguments:
ListContainers [-filter (dongle|software)]
ListLicenses [-sn SERIAL]
ApplyLicense -path PATH
CreateSoftwareContainer
GetFingerprint -sn SERIAL -path PATH
CheckStatus
Report -path PATH
Activate -t NEO_TICKET_ID -sn SERIAL
Reactivate -t NEO_TICKET_ID -sn SERIAL
RequestActivationFile -fingerprintPath PATH -outPath PATH -t NEO_TICKET_ID
RequestReactivationFile -fingerprintPath PATH -outPath PATH -t NEO_TICKET_ID
RequestEmergencyActivation
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Emergency licenses

If you need a license for a limited time (for instance while waiting for some support), use an
emergency license.

1. To activate an emergency license , use the RequestEmergencyActivation command:
□ These licenses activate all Euresys products.
□ They are valid for 8 days.
□ You can repeat this a maximum of 3 times.
□ For security reasons, you cannot activate emergency licenses on virtual machines.

> NeoLicenseManagerCL.exe RequestEmergencyActivation

License recovery with a software container

If you have to reinstall the system and lost your licenses:

1. Create a software container.

2. Activate the license with the old Ticket ID to try to recover all the licenses associated to the
container where you first activated this Ticket ID.

This only works if:
□ It is done in a new, empty container.
□ The system is recognizable (the hardware is more or less the same).

3. If this does not work, perform a reactivation.

Reactivation

If the recovery does not work or if you lost your licenses and the system has changed
significantly (for instance after the failure and replacement of a hardware component), you
need to perform a reactivation.

□ This transfers your lost license on a container on the new system.
□ By default, the reactivation is disabled.

1. Contact the support to obtain a reactivation authorization for the corresponding Ticket ID.

2. Once the reactivation is authorized, follow the license activation procedure described above
but use the Reactivate command instead of Activate.

NOTE
Make sure that you reactivate only a license from a lost or broken container,
as that container will be blacklisted and you cannot use it again for licensing
procedures.

Error reporting

If anything fails, the Neo License Manager returns an error and information about it in stderr.

1. To recover the stderr log in the command line, you can use 2> redirection, as follows:

NeoLicenseManagerCL.exe Activate -t TT5YY-HYAGN-Q2PBU-U7K7J-DKJJQ -sn 130-3245488904 2>c:\tmp\error.log

2. If you need more information, use the Memento tool from Euresys.
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3. To check the status of the licensing system on your computer at any time, use the CheckStatus
command of the Neo License Manager.

> NeoLicenseManagerCL.exe CheckStatus
** Starting List Product Item for box 130-3613949292 and firm code 6001261 **
Found Productcode (Dependency: 0x7): 4305
Text (#=20, Dependency 0x00): "Open eVision EasyOCR"
Extended Protected Data (#=16, Type 136, Dependency 0x07): 6c 63 64 63 00 01

9b 05 00 00 00 00 00 00 01 00
** List Product Item finished without errors **

Open eVision Getting Started PART IV Neo Licensing System



57

5. Using the Offline Command Line

● When you order a Neo License, Euresys sends you a Ticket ID required to activate the license
on your system.
□ A Ticket ID is made of 5 groups of 5 alphanumeric characters separated by a dash.

For example: TT5YY-HYAGN-Q2PBU-U7K7J-DKJJQ
□ You can activate your license either directly on the computer, as a software license, or on

a Neo USB Dongle, that you can buy from Euresys.

● In the case of the software container, the license is strongly linked to a single computer
system, while with a dongle you can move it easily from computer to computer.

When to use the offline activation

Use the offline activation when the system on which you want to activate the license is not
connected to the Internet. Nevertheless, to activate the license, you must have access to
another computer that is connected to the Internet.

□ The system that needs a license and is not connected is called the target system.
□ The connected system is the online system.
□ Both systems need to have the Neo License Manager installed.

TIP
Neo USB Dongle activation
This procedure works for activating both dongles and software containers.
However, it is much easier to connect a dongle directly to the online system
and use the online procedure.

Select a container

1. To select a license container, use the ListContainers command of the Neo License Manager.

All the containers compatible with Euresys licenses are listed:

> NeoLicenseManagerCL.exe ListContainers
Container list:

130-3613949292 (software)
□ A software container appears in the list with a serial number starting with 130-.
□ A dongle appears in the list with a serial number starting with 3-. This serial number is

also written on the dongle itself.
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2. To create a software container, use the CreateSoftwareContainer command of the Neo License
Manager.

> NeoLicenseManagerCL.exe CreateSoftwareContainer
Software container 130-3245488904 has been created.

If you already have a software container on your system:
□ We highly recommended you to use that one.
□ Create a new software container only if the old one is broken for any reason. The old

license container unavailable for activation purposes.

3. Copy the serial number of the container you want to use for the next step.

Activate a license

The offline license activation is a 3 steps procedure:

1. On the target system, retrieve the fingerprint:

a. To retrieve the identification information, also called the fingerprint, use the
GetFingerprint command of the Neo License Manager.

> NeoLicenseManagerCL.exe GetFingerprint -sn 130-3245488904 -path "myfingerprintfile.fgp"

This command generates a fingerprint file.

b. Copy this file to the online system.

2. On the online system, request a license activation file:

a. To generate the license activation file, use the RequestLicenseFile command of the Neo
License Manager.

b. Use this command with the Ticket ID and the fingerprint file of the target system.

> NeoLicenseManagerCL.exe RequestActivationFile -fingerprintPath "myfingerprintfile.fgp" -t TT5YY-HYAGN-Q2PBU-
U7K7J-DKJJQ -outPath "mylicensefile.lif"

c. Copy this file to the target system.

3. On the target system, apply the license.

a. To activate the license in the chosen container use the ApplyLicense command of the Neo
License Manager.

b. Use this command with the license activation file.

> NeoLicenseManagerCL.exe ApplyLicense -path "mylicensefile.lif"

Check the Neo License presence

1. To check the presence of the license, use the ListLicenses command of the Neo License
Manager.

The new license appears under the serial number of the license container.

> NeoLicenseManagerCL.exe ListLicenses
Licenses on container 130-3613949292 (software):

Open eVision EasyOCR
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Troubleshooting

Command line help

● To get help about the syntax and the usage of the command line, use the Help command:

> NeoLicenseManagerCL.exe Help
Here are the available commands and their arguments:
ListContainers [-filter (dongle|software)]
ListLicenses [-sn SERIAL]
ApplyLicense -path PATH
CreateSoftwareContainer
GetFingerprint -sn SERIAL -path PATH
CheckStatus
Report -path PATH
Activate -t NEO_TICKET_ID -sn SERIAL
Reactivate -t NEO_TICKET_ID -sn SERIAL
RequestActivationFile -fingerprintPath PATH -outPath PATH -t NEO_TICKET_ID
RequestReactivationFile -fingerprintPath PATH -outPath PATH -t NEO_TICKET_ID
RequestEmergencyActivation

Emergency licenses

If you need a license for a limited time (for instance while waiting for some support), use an
emergency license.

1. To activate an emergency license , use the RequestEmergencyActivation command:
□ These licenses activate all Euresys products.
□ They are valid for 8 days.
□ You can repeat this a maximum of 3 times.
□ For security reasons, you cannot activate emergency licenses on virtual machines.

> NeoLicenseManagerCL.exe RequestEmergencyActivation

License recovery with a software container

If you have to reinstall the system and lost your licenses:

1. Create a software container.

2. Activate the license with the old Ticket ID to try to recover all the licenses associated to the
container where you first activated this Ticket ID.

This only works if:
□ It is done in a new, empty container.
□ The system is recognizable (the hardware is more or less the same).

3. If this does not work, perform a reactivation.
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Reactivation

If the recovery does not work or if you lost your licenses and the system has changed
significantly (for instance after the failure and replacement of a hardware component), you
need to perform a reactivation.

□ This transfers your lost license on a container on the new system.
□ By default, the reactivation is disabled.

1. Contact the support to obtain a reactivation authorization for the corresponding Ticket ID.

2. Once the reactivation is authorized, follow the license activation procedure described above
but use the Reactivate command instead of Activate.

NOTE
Make sure that you reactivate only a license from a lost or broken container,
as that container will be blacklisted and you cannot use it again for licensing
procedures.

Error reporting

If anything fails, the Neo License Manager returns an error and information about it in stderr.

1. To recover the stderr log in the command line, you can use 2> redirection, as follows:

NeoLicenseManagerCL.exe Activate -t TT5YY-HYAGN-Q2PBU-U7K7J-DKJJQ -sn 130-3245488904 2>c:\tmp\error.log

2. If you need more information, use the Memento tool from Euresys.

3. To check the status of the licensing system on your computer at any time, use the CheckStatus
command of the Neo License Manager.

> NeoLicenseManagerCL.exe CheckStatus
** Starting List Product Item for box 130-3613949292 and firm code 6001261 **
Found Productcode (Dependency: 0x7): 4305
Text (#=20, Dependency 0x00): "Open eVision EasyOCR"
Extended Protected Data (#=16, Type 136, Dependency 0x07): 6c 63 64 63 00 01

9b 05 00 00 00 00 00 00 01 00
** List Product Item finished without errors **
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6. Neo Licensing System FAQ

Why the new Neo Licensing System?

● The old (legacy) licensing system of Open eVision was introduced about 15 years ago. Since
then, licensing technologies have evolved significantly.

● We now introduce the Neo Licensing System to take advantage of this evolution and provide
numerous improvements in this release and in future versions of Open eVision.

How do I use a Neo License?

● After ordering a Neo License, you will receive a document (typically a shipping note)
containing a unique Ticket ID.

● With this Ticket ID, use the new Neo License Manager to activate your Neo License in the
container of your choice (a Neo USB Dongle (PC6514) or a Neo Software Container).

● Once the Neo License is activated, you are able to use Open eVision.

What should I do with my Ticket ID after activation?

● Very carefully store your Ticket IDs where you can retrieve them easily. In addition, we
recommend that you keep track of which Ticket ID is activated on each dongle, system or
machine.

● If you ever experience a licensing issue, this Ticket ID is required when you contact your
distributor or Euresys support.

On which device can I activate my Neo License?

● You can activate your Neo License either on a Neo USB Dongle (PC6514) or on the hard drive
of a compatible computer system via Neo Software Container.

Do I have to choose where I want to activate my Neo License when I
order it?

● No, you just have to order a Neo License for the product you want to use.
□ Neo Licenses of Open eVision libraries have product codes starting with 43.
□ These licenses are valid for activation on a Neo USB Dongle (PC6514) or on a Neo Software

Container.

Can I use a Neo License with an older legacy Euresys dongle?

● No, Neo Licenses can only be activated on a Neo USB Dongle (PC6514).

● The old USB Dongle (PC6512) and the PAR Dongle (PC6513) cannot be used with Neo
Licenses.
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Can I use a Neo License with a dongle from another company?

● No, you can only activate a Neo License on the Neo USB Dongle (PC6514) purchased from
Euresys or from a Euresys distributor.

When should I use a Neo Software Container instead of a dongle?

● We recommend that you only use a Neo Software Container if your system cannot handle a
USB dongle.

● Neo Software Containers are locked to a computer system and computers are more fragile
than USB dongles. USB dongles can easily be moved to a replacement computer in case of a
failure of the computer or in case of an upgrade.

I have activated a Neo License on a Neo Software Container on my
computer. Can I move it to a new computer?

● No, once you have activated a Neo License on a Neo Software Container on a computer, it is
locked to that computer and it cannot be moved to another computer or to a Neo USB
Dongle.

I have activated a Neo License on a Neo Software Container on my
computer. My computer no longer worked and had to be repaired. What
can I do?

● If your computer has been repaired by replacing the defective parts, try to reactivate your
license(s) from the Neo License Manager using the same Ticket IDs as originally used on this
computer. If your computer is still recognized by the Neo License Manager, the license(s) will
be restored.

● If this process fails, or if your computer cannot be repaired and you wish to use a new
computer, please contact your distributor or Euresys support to request the reactivation of
the license(s). You will have to provide the original Ticket IDs used for that computer. When
that reactivation is granted, you can activate the corresponding license(s) again on a new
Neo Software Container.

Where can I find the new Neo License Manager?

● The Neo License Manager application is available both as a stand-alone installer and within
the Open eVision installation package (starting with release 2.13).

Can I use the Neo License Manager via command line?

● Yes, the Neo License Manager is available both as a Graphical User Interface application and
as a command line executable.

● The command line executable is less user friendly, but allows to automate the management
of Neo Licenses.
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Can I use a legacy activation key with the Neo Licensing System?

● No, legacy activation keys only work with the legacy licensing system.

● The legacy licensing system, both dongles and software, however will still be supported for
the foreseeable future.

Can the new Neo License Manager activate legacy licenses?

● No, the Neo License Manager application only manages Neo Licenses.

● The previous (legacy) License Manager, however, remains available in the Open eVision
package to manage legacy licenses.

I have (legacy) non-Neo USB Dongles or software licenses, can I still use
them with Open eVision 2.13 and higher?

● Yes, the licensing systems used before Open eVision 2.13 are still active and supported. They
will remain active and supported for the foreseeable future.

● However, for new projects, we highly recommend using the Neo Licensing System.

Can I restrict the choice of licensing system (Neo Licensing System or
legacy) in my application?

● Yes. A new Preconfiguration object is available in Open eVision (as of Open eVision 2.13) to
allow users to restrict the use to a particular licensing system.

● Note that using this feature is optional.

Are emergency licenses available with the Neo Licensing System? Are
the emergency licenses of the Neo Licensing System and the legacy
licensing system independent?

● Yes, emergency licenses are available with the Neo Licensing System, they are independent of
the legacy emergency licenses.

● Each of these licensing systems provides three time-limited emergency licenses.

Are all Open eVision libraries and bundles available with the new Neo
Licensing System?

● All current Open eVision libraries and bundles are available with the new Neo Licensing
System.

● However, some old legacy bundles may not be available with the new Neo Licensing System.
They remain available with the old licensing systems only.
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What can I do if I have lost a Ticket ID?

● The Ticket ID is the unique identifier of a license. It is very important and must be securely
stored. If you ever experience a licensing issue, this Ticket ID is required when contacting
your distributor or Euresys support.

● Ticket IDs that have been activated on a Neo USB Dongle can be retrieved by Euresys
technical support from the dongle serial number.

● However, support for licenses stored in a Neo Software Container will not be possible if the
Ticket ID has been lost.

Is an Internet connection required to activate a Neo License?

● Yes, an Internet connection is required to activate a Neo License on a Neo USB Dongle or on a
Neo Software Container.

● However, an Internet connection is not required to run Open eVision after the Neo License
has been activated.

Do I have to provide the serial number of a Neo USB Dongle when
ordering a Neo License?

● No, you do not have to provide the serial number of a Neo USB Dongle when ordering a Neo
License.

● You can activate a Neo License either on a Neo USB Dongle (PC6514) or on the hard drive of a
compatible computer system via a Neo Software Container.

● The link between the Neo License and the Neo USB Dongle is recorded during the activation.

Is it possible to add licenses for additional Open eVision libraries to Neo
USB Dongles that are already in the field?

● Yes. Just order the additional Neo Licenses and activate the new Ticket IDs on the existing
Neo USB Dongle as usual.

● The activation process is additive. It will add the new licenses to the licenses already
activated on the dongle. The existing licenses will not be lost.

● Please note that this operation requires an Internet connection.

Can I use a Neo License with older versions of Open eVision?

● No, the Neo Licensing System is only available as of Open eVision 2.13.

● However, the existing licensing systems remain available with the earlier releases of eVision
and Open eVision.

Is the 30-day evaluation license available with the Neo Licensing System?

● Yes. The Product Code is 4300.

● The time-limited 30-day evaluation license can be activated a single time either on a Neo
USB Dongle (PC6514) or on a Neo Software Container.
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